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1. | Bien configuré Sibelius 

1.1. Options générales 

1.1.1. Réglages Playback Audio 

 

• Onglet PLAY > SETUP > PLAYBACK DEVICES (Petite icone) 

• En bas à gauche de la fenêtre > Onglet Audio Engine Options… 

• Choisir votre interface Audio 

 

1.1.2. Retirer le son de démarrage de Sibelius 

 

• Onglet File > Preferences > Other  

• Onglet When Sibelius Starts > Décocher Play music 

 

1.1.3. Changer la texture de fond de la partition 

 

• Onglet File > Preferences > Textures 

 

Conseil : 

Choisir une texture de préférence pas blanche.. 

Exemple :  

Paper : Paper, cream filter 

Desk : Paper, papyrus 

 

1.1.4. Laptop sans pavé numérique 

 

Solution 1 : Pour utiliser les raccourcis clavier de l'ordinateur portable avec Sibelius : 

1. Choisissez Fichier > Préférences. 

2. Sélectionnez la page Raccourcis clavier. 

3. Sélectionnez les raccourcis clavier de l'ordinateur portable dans le menu 

Ensemble de fonction actuel en haut de la boîte de dialogue. 

4. Cliquez sur OK. 

 

 

Désormais, au lieu d'utiliser les chiffres du pavé numérique, vous pouvez utiliser les chiffres standard 

en haut de votre clavier, qui correspondent aux mêmes chiffres sur le pavé numérique. Lorsque cet 

ensemble de fonctions est utilisé, utilisez Maj + 1 à Maj + 9 pour entrer des intervalles au-dessus 

d'une note.  



 

Solution 2 : Acheter un pavé numérique séparé à connecter à votre ordinateur via USB, ce qui vous 

permettra d'utiliser les raccourcis standard de Sibelius. 

 

 

1.2. Pour chaque nouvelle partition 

1.2.1. Paramètre de mise en page 

• Onglet Layout > Document setup > Normal Staff Size 

 

Conseils : 

Partition individuelle : 7.0mm 

Dans les scores : 5.0mm.  

Peut-être grossi pour des élèves débutants  

 

• Onglet Layout > Staff Spacing > Space between 

 

Conseils : 

Partition individuelle :  Stave 9.0 | Systems 12.0  

Dans les scores Stave 6.5 | Systems 9.0 

 

1.2.2. Réglages des Règles de gravure 

 

• Onglet Appearance > Engraving Rules 

 

1.2.2.1. Accidentals and Dots 

 

o Réglages des règles d’altérations 

Conseil : 

Cocher > Show cautionary accidentals in parentheses 

Cocher > Apply auto cautionaries only up to first note of next bar  



1.2.2.2. Bar numbers 

 

o Réglages de l’affichage des numéros de mesures 

 

Conseil : 

Cocher > Hide at rehearsal marks 

 

o Possibilité de régler les styles de texte (cf. 1.2.2.6) 

 

1.2.2.3. Chord Symbols 

 

o Réglages de l’affichage des accords textes 

Conseil : 

Cocher > Chords text only 

 

o Suffix element : définir à votre guise 

o Possibilité de régler les styles de texte (cf. 1.2.2.6) 

 

1.2.2.4. Instruments 

 

o Réglages de l’affichage des noms des instruments 

 

Conseil : 

Instrument and staff names : définir à votre guise 

 

o Possibilité de régler les styles de texte (cf. 1.2.2.6) 

 

1.2.2.5. Rehearsal Marks 

 

o Réglages du format des repères de répétition  

o Possibilité de régler les styles de texte (cf. 1.2.2.6) 

 

 

  



1.2.2.7. Text Style 

 

o Font  

o Souligner  

o Bordure et cercle… 

 

1.2.3. Réglage de la lecture audio 

 

• Onglet PLAY > Performance 

Les paramètres :  

• Espressivo : réaction de la lecture au nuance et articulation 

• Rubato : Réaction de la lecture au rubato et ritardendo  

• Rythmic feel : Feeling rythmique de lecture 

  

 

  



3. | Création de partition 

3.1. Utilitaire de création 

Cet utilitaire peut faire gagner du temps, mais en soit ne sert à rien.. 

Les champs sont explicites mais tout est modifiable part la suite dans l’interface. 

 

3.2. Découverte de l’interface 

 

 

3.2.1. Les onglets du ruban 

 

FILE : différent des autres onglets. 

il permet d'importer et d'exporter des fichiers dans différents formats, d'imprimer, d'accéder à des 

fonctionnalités spéciales d'apprentissage et d'enseignement, d'obtenir de l'aide détaillée. 

 

  



Les autres onglets sont classés selon l'ordre dans lequel vous effectuez habituellement des tâches tout 

en travaillant sur une partition, de sorte que lorsque vous avancez dans un projet du début à la fin, vous 

travaillez généralement de gauche à droite dans les onglets du ruban. 

 

HOME : Opérations de configuration basique de la partition.  

• Ajout et suppression d'instruments 

• Ajout et suppression de mesures 

• Transposition du score 

• Opération de presse-papiers 

• Les filtres Sibelius 

 

NOTE INPUT : Commandes relatives à la saisie de note et édition de notes 

• Choix du type de saisie 

• Outil -plet (triplet, quintuplet) 

• Répétition ou transposition d’une séquence 

• La commutation de voix 

• Outils de composition tels que l'explosion/réduction 

• Outils de transformations telles que la rétrogradation, l'inversion, etc. 

 

 

NOTATIONS : Toutes les symbole et lignes de base qui ne sont pas des notes.  

• Changement de clef, d’armure, de signature rythmique et de barres de mesures 

• Outils lignes 

• Outils symbole transposition d’une séquence 

• Modifications des hampes et des têtes de notes 

• Outil crochet et accolade 

• Ajout d’image 

 

TEXT : Tous les outils de textes. 

• Contrôles de style et de taille de police 

• Choix du style de texte 

• Outils paroles 

• Symboles d'accords 

• Repère de répétition  

• Numérotation de mesures et de pages.  

  



PLAY : Tous les outils de lecture audio. 

• Configuration audio  

• Commandes de transport,  

• Outils Live Tempo,  

• Outils Live Playback 

• Options d’interprétation les marques de votre partition pendant la lecture.  

 

 

LAYOUT : Configuration de mise en page 

• Taille des pages  

• Taille et espacement des portées 

• Outil masquage des portées 

• Options de mise en page magnétique 

• Option de format  

 

APPEARANCE : Options qui affectent l'apparence visuelle de la partition  

• Choix du style et des règle de gravure 

• Espacement des notes et des noms d'instruments,  

• Commandes pour réinitialiser la conception, la position ou d'autres propriétés des 

objets de votre partition 

 

PARTS (Sibelius | Ultimate uniquement) : Options relatives aux parties individuelles des instruments. 

 

REVIEW : Ajout et révision de commentaires, création et gestion de plusieurs versions dans votre 

partition, comparaison de révisions et accès à divers plug-ins de relecture.  

 

VIEW : Modification des paramètres liés à l'apparence des "éléments invisibles". 

• Masquage ou affichage de panneaux supplémentaires pour des opérations 

avancées 

• Arrangement ou basculement entre les fenêtres de documents ouvertes. 

 

 

  



3.3. Navigation et affichage dans Sibelius 

3.3.1. Navigation dans la Partition :  

 

Pour vous déplacer dans la partition, faites glisser la partition avec votre souris. Utilisez le "Navigateur" 

("View > Panels >Navigator"), une vue miniature de certaines pages, pour une navigation plus facile. 

 

3.3.1. Zoom Rapide :  

Utilisez les raccourcis clavier Command + "+" pour zoomer et Command + "-" pour dézoomer. Le zoom 

peut également être effectué avec le raccourcis :  Command + molette de la souris. (Zoom toujours sur 

la sélection) 

 

3.3.2. Vue Panoramique :  

Pour passer en mode Panorama, utilisez le menu "View > Document View > Panorama" ou le raccourci 

Shift+P. Cette vue affiche la partition sur une seule page, vous permettant de travailler sans défilement 

vertical. 

 

3.3.3. Afficher et masquer les Panneaux :  

Utilisez les cases à cocher dans le menu "View > Panels" pour masquer ou afficher les panneaux. Les 

panneaux les plus utiles pour l’écriture sont : "Transport" (Outil de lecture), "Navigator" (affichage de la 

partition en miniature)et le "Keypad" (Affichage du pavé de fonction). 

 

3.3.4. Conseils d'Utilisation :  

Apprenez les raccourcis clavier pour gagner du temps.  

 

 Fonction Raccourcis 

Zoom   

 Zoom in ⌘ + « + » ou ⌘ + molette  

 Zoom out ⌘ + « - » ou ⌘ + molette  

Vue panoramique   

 Activer ou désactiver la vue 

panoramique 

⇧ + P 

Changement d’outil   

 Annuler la sélection ou les 

opérations 

Esc 

Se déplacer entre les 

notes 

  



 Note précédente ← 

 Note suivante → 

 Mesure précédente ⌘ + ← 

 Mesure suivante ⌘ + → 

 Sélection groupes de notes suivantes ⇧ + ← 

 Sélection groupes de notes 

précédentes 

⇧ + → 

 Sélection groupes de mesures 

suivantes 

⇧ + ⌘ + ← 

 Sélection groupes de mesures 

précédentes 

⇧ + ⌘ + → 

 Sélectionner un passage Clic + Shift + Clic 

 Tout sélectionner Cmd + A 

 

 
4. | Définir l’instrumentarium 

 

Pour définir l’instrumentarium nous avons 3 techniques :  

• Dans le menu de configuration rapide au lancement du logiciel. 

• En cliquant sur le 1er ruban « ajout suppression d’instruments » 

• En utilisant le raccourcis clavier : touche I 

 

 

 

5. | Changement de signature rythmique, armure, barre 

de mesure, clé, etc… 

 
RDV sur le ruban NOTATIONS 

 

On commence par définir le nombre de mesure, la signature rythmique, l’armure et les clés 

  



5.1. Les mesures  

 

Pour définir le nombre de mesures nous avons 2 techniques :  

• RDV sur le ruban HOME > Bars . 

• En cliquant sur la flèche en dessous de Add nous pouvons : 

o Ajouter une mesure à la fin 

o Ajouter une mesure à la sélection 

o Ajouter plusieurs mesures 

• En utilisant les raccourcis clavier :  

o Cmd + B : Ajouter une mesure à la fin 

o Shift + Cmd + B : Ajouter une mesure à la sélection 

o Alt + B : Ajouter plusieurs mesures 

 

5.2. Changement de signature rythmique 

 

Pour définir la signature rythmique nous avons 3 techniques :  

• Dans le menu de configuration rapide au lancement du logiciel. 

Une fois le projet commencé, après avoir sélectionné les mesures souhaitées avec Clic + Shift + Clic 

ou toutes les mesure avec Cmd + A : 

• En cliquant sur le ruban NOTATION > « Time Signature » 

• En utilisant le raccourcis clavier : touche T 

Dans ce menu : Sélectionner la métrique souhaitée ou la créer sur « More Options » 

 

5.3. Changement de clef 

 

Pour définir un changement de clef rythmique nous avons 2 techniques :  

Sélectionné les mesures souhaitées avec  Shift + clic ou toutes les mesure avec Cmd + A : 

• En cliquant sur le ruban NOTATION > « Clef » 

• En utilisant le raccourcis clavier : touche Q 

Dans ce menu : Sélectionner la métrique souhaitée ou la créer sur « More Options » 

 

  



5.5. Changement d’armure 

 

Pour définir la signature rythmique nous avons 3 techniques :  

• Dans le menu de configuration rapide au lancement du logiciel. 

Une fois le projet commencé, après avoir sélectionné les mesures souhaitées avec Shift + clic ou toutes 

les mesure avec Cmd + A : 

• En cliquant sur le ruban NOTATION > « Key Signature » 

• En utilisant le raccourcis clavier : touche K 

Dans ce menu : Sélectionner la métrique souhaitée ou la créer sur « More Options » 

 

 
  

6. | Saisie de notes 

Pour saisir et éditer des notes dans Sibelius, il existe plusieurs méthodes, notamment la saisie avec la 

souris, le clavier MIDI, le clavier d'ordinateur, etc. Cependant, l'utilisation du clavier d'ordinateur est 

souvent la plus rapide. Uniquement celle-ci sera traité dans ce document. 

 

RDV sur le ruban NOTE INPUT 

 
Comprendre l’écriture rapide en 4 outils : 

 

Rythme = Pavé numérique 

Notes = A B C D E F G (cf. American system) 

Saut d’octave =  Cmd+⬆︎/⬇︎.  

Saut de note = ⬆︎/⬇︎ 

 
Pour écrire : on tape le rythme puis les notes 

 

 

 

 

  



6.1. Le keypad 

Élément essentiel : Comprendre le pavé numérique 

Pour masquer ou afficher le Pavé : Sélectionner Affichage> Panneaux> Pavé ou utiliser le 

raccourci Cmd+Alt+K 

 

 

 

 

 

 

 

 

 

 

 

 

 
  



 

De base le pavé correspond à : 

 

Num Lock = 
Cancel 

/ = Stacatto « * » = Tenuto 
« - » = Retour 
au premier 
panneau 

7 = bécar 8  = dièze 9 = bémol 
 

« + » = 
Panneau 
suivant 

4 = noire 5 = blanche 6 = ronde 

1 = triple 
croche 

2 = double 
croche 

3 = croche 
 

Enter = 
Liaison 

(directe) 
0 = silence . = pointée 

 

ATTENTION il existe 6 panneaux de pavé 

Pour changer de pavé il existe 3 options : 

 

- Cliquer sur :    

- Touche F7 à F12 

- Naviguer entre les panneaux en utilisant les boutons : 

 : layout suivant (raccourci + du pavé numérique) 

  (Raccourci – du pavé numérique) 

 

 
 

 

 

 

  



6.1.1. Les panneaux du Keypad 

 

  Rythme 1  (F7) 

 

Contient les valeurs de note et les altérations les plus 

courantes. 

 

 

 

 

Rythme 2    (F8) 

 

Contient le reste de valeurs de notes 

 
 
 
 
 
 
 

 

 

Ligatures/trémolos (F9) 

 

Concerne l’édition des groupements de ligature et la création 

des trémolos. 

 

 

 



Articulations 1  (F10) 

Concerne les altérations (trois sont configurables par vos soins) 

 

 

 

 

 
 

Articulations 2 (F11) – sur mac il faut désactiver le raccourcis système pour 

que ca fonctionne.. 

 

Concerne les articulation jazz, lignes d’arpège et les mesures 

de reprise. 

 
 
 
 
 
 

Altérations (F12) 

Contient les altérations peu communes. 

 

 

 

 

Choix des couches 

 Enfin, au pied de chaque pavé se trouve le choix des voix  



Grace à cet outil, nous pouvons écrire toutes les notes et les rythme de la partition à l’exception des 

rythmes « -let » 

 

6.1.2. Les rythmes « -let »  

 
Écrire la première note dans la bonne valeur (une croche pour un triolet de croche), puis la sélectionnée. 

Pour la suite, 2 techniques : 

• Rdv sur le ruban NOTE INPUT > Outil « Triplet » ou flèche en dessous de « Triplet » pour plus de 

choix  

• Raccourcis Cmd + « chiffre correspondant » (Cmd + 3 = Triolet, Cmd + 5 = Quintolet, etc..) 

 
 
Une fois toutes les notes et rythme terminé, il est temps d´y ajouter les lignes et autres signes. 

 

7. | Les lignes et symboles 

7.1. Les barre de mesures  

 
Pour éditer une barre de mesure : 

• Sélectionner la barre de mesure souhaitée 

• RDV sur le ruban NOTATIONS > Common > Barline  

• Sélectionner la flèche en dessous et choisir la ligne souhaité. 

 

 

7.2. Les lignes  

 
• Sélectionner le passage où insérer la ligne 

• RDV sur le ruban NOTATIONS > Lines > cliquer sur la flèche en bas à droite 

• Choisir la ligne souhaitée 

 

7.3. Les symboles  

 
• Sélectionner le passage où insérer le symbole 

• RDV sur le ruban NOTATIONS > Symbols > cliquer sur la flèche en bas à droite 

• Choisir la ligne souhaitée 

  



8. | Les bases de la mise en page 

 
Raccourci utile : Sélectionner la 1ere note d’un rythme et appuyer sur X pour inverser les hampes. 

A vérifier avant la mise en page :  

• Dans le ruban VIEW > Invisible  

• Cocher : « Layout Marks » 

 

8.1. Regrouper les mesures vides 

 

• Dans le ruban LAYOUT > Breaks 

• Sélectionner « Show Multirests » ou utiliser le raccourci : « Shift + Cmd + M » 

 

8.2. Automatiser les sauts de systèmes 

 

• Dans le ruban LAYOUT > Breaks 

• Sélectionner « Auto Breaks » 

• Cocher « Use auto system breaks » 

• Cocher « Every X bars »  

 

8.3. Corriger manuellement les sauts de systèmes 

  
• Dans le ruban LAYOUT > Breaks 

• Sélectionner la barre de mesure souhaité 

• Cliquer sur « System Break »  

  

8.4. Corriger manuellement les sauts de pages 

  
• Dans le ruban LAYOUT > Breaks 

• Sélectionner la barre de mesure souhaité 

• Cliquer sur « Page Break » ou utiliser le raccourci : « Cmd + Enter » 

 

8.5. Focus sur les Portées  

Économisez de l'encre en masquant les portées inutiles avec "Layout > Hiding Staves > Focus on 

Staves". Réactivez cette fonctionnalité pour revenir à l'affichage normal.  



9. | Extraire score et partitions séparées 

 

Maintenant RDV sur le ruban FILE pour finaliser notre partition  

 

9.1. Impression de la Partition  

Imprimez votre partition en utilisant le ruban "File > Print". Vous pouvez personnaliser les options 

d'impression. (Score only, Score + parties séparées, etc…) 

 

9.1. Exportation de la Partition  

 
L’onglet Export permet d’exporter l’audio, le pdf ou la partition en midi 

 

 

10. | Écriture avancée 

10.1. Outil Filtres 

 

L'onglet "Filtre" est utilisé pour restreindre la sélection d'éléments dans votre partition. Il vous permet 

de choisir le type d'objets sur lesquels vous souhaitez travailler. 

 

10.1.1. Utilisation de l'Onglet "Filtre"  

 

• Dans le ruban HOME > Select 

• Sélectionner « Filters » 

• Après avoir ouvert l'onglet « Filters », vous verrez une liste d'options :  

o Text, Lines, Note and Rests, etc. 

• Choisissez le type d'objets sur lesquels vous souhaitez appliquer une action en cochant la 

case correspondante. 

• Une fois que vous avez sélectionné le type d'objets, effectuez une action comme la 

suppression, le déplacement, ou l'édition. Seuls les objets sélectionnés seront affectés. 

Conseils : 

Expérimentez les différentes options de filtre pour comprendre toutes les fonctionnalités disponibles. 

  



10.3. Outils de grouping rythmique  

 

10.3.1.  Appliqué de manière générale 

 

Pour appliquer un grouping rythmique récurent (comme une clave sur un morceau impair) l’outil idéal 

est « Time Signature ». 

 

• Sélectionner le passage désiré 

• Dans le ruban NOTATIONS > Common, sélectionner « Time Signature » 

o Ou appuyer sur la touche « T » 

• Cliquer sur More Options  

• Cocher « Other » pour créer un chiffrage sur mesure 

• Cliquer ensuite sur Beam and Rest Groups…  

• Une fenêtre de dialogue s’ouvre permettant de définir le grouping des croches, doubles et 

triples et de séparer les rythmes -let 

• Une fois les paramètres définis cliquer sur OK puis sur OK :  

 

10.3.2.  Via le pavé numérique  

 

Pour appliquer un grouping rythmique non récurent, l’outil idéal est « Beams/tremolos ». 

 

• Pour accéder à l’outil RDV sur le 3ème onglet du Keypad ou raccourcis clavier F9 

• Sélectionner la note où appliquer l’outil 

• Sélectionner la touche du pavé numérique correspondante à l’outil souhaité 

• Touche « Echap » pour quitter l’outil  

 

  



10.4. Les appogiatures 

 

Pour ajouter des appogiature, l’outil idéal est « More notes ». 

 

• Pour accéder à l’outil RDV sur le 2ème onglet du Keypad ou raccourcis clavier F8 

• Sélectionner la note où appliquer l’outil 

• Sélectionner l’outil Appoggiatura ou Acciaccatura à la souris ou avec la touche du pavé 

numérique correspondante 

• Touche « Echap » pour quitter l’outil 

 

10.5. Outil Ossia 

 

Pour créer une portée Ossia sur une partie. 

 

• Sélectionner le passage désiré 

• Dans le ruban HOME > Instruments, sélectionner « Ossia Staff » 

• Choisir Above ou Below  

 

Conseils : 

• Sélectionner le passage à copier dans l’Ossia maintenir la touche « Alt » et cliquer à l’endroit 

où vous souhaité le coller 

 

10.6. Ecriture par intervalle   

 

• Sélectionner la note ou le passage désiré 

• Avec les nombres définir l’intervalle (3 = 3ce, 4 = 4te, etc...) appuyer sur la touche souhaitée 

le passage monte à l’intervalle désiré 

• Utiliser Shift pour descendre. 

 

Exemple :  

• Touche  « 3 » monter d’une tierce  

• Touches  « Shift » + « 3 » descendre d’une tierce 

  



10.7. Ecriture à plusieurs voix  

 

Pour écrire à plusieurs voix sur la même portée, le plus simple est de d’abord créer un intervalle, puis 

de sélectionner la note que l’on souhaite faire passer en 2ème voix. 

 

• Une fois sélectionné, cliquer sur le sélecteur de couches du Keypad 

• Ou RDV dans le ruban NOTE INPUT > Voices > Voice 

• Touche « Echap » pour quitter l’outil 

 

Conseils : 

• Touche « X » pour inverser les hampes 

 

10.8. Outil transposition 

 

• Sélectionner le passage désiré 

• Dans le ruban NOTE INPUT > Note Input > Transpose ou raccourcis clavier « Shift » + « T » 

• Une fenêtre de dialogue apparait, diffinir les champs et cliquer sur OK  

 

10.9. Outils de transformations 

Les outils de transformations comme : Double, Halve, Retrograde, Invert, etc sont des outils 

compositionnels à connaitre. 

• Sélectionner le passage désiré 

• Dans le ruban NOTE INPUT > Transformations, sélectionner l’outil souhaité 

• Explicite.. 

 

10.10. Outils Exploser / Réduire 

Les outils exploser et réduire permettent ; d’exploser des accords en plusieurs voix ou de regrouper 

plusieurs voix sous forme d’accord 

• Sélectionner le passage désiré 

• Dans le ruban NOTE INPUT > Arrange > Explode ou Reduce 

• Une fenêtre de dialogue apparait, sélectionner le nombre de portées desire cliquer sur OK 

• Une seconde fenêtre de dialogue apparait, choisir de créer de nouvelles portées ou utiliser 

des portées existantes, puis cliquer sur OK  



10.11. Cadence sans tempo 

• Compter le nombre de temps nécessaire à l’écriture de la cadence. 

• Créer une mesure avec le bon nombre de temps 

• Avec l’outil Inspector cacher le chiffrage de mesure 

Attention : Pour les cadences trop longue ça ne fonctionne pas. 

 

Pour les cadences longues, il faut découper la cadence -> chaque mesure vaut une ligne 

• Créer des mesures avec le bon nombre de temps 

• Avec l’outil Inspector cacher le chiffrage de mesure 

• Sélectionné les mesures sauf la 1ere de la cadence 

• Aller sur le ruban TEXT > Numbering > Bar Number Change 

• Cocher No bar number (and don’t count bar) puis OK 

 

 

11. | Les textes 

11.1. Symboles d’accord 

Les symboles d’accords doivent être ancrés sur une note ou un silence 

• Sélectionner la note ou le silence 

• Utiliser le raccourcis clavier « Cmd » + « K » 

• Ecrire l’accord désiré ( Format américain )  

Cf. 1.2.2.3. Chord symbols pour la configuration 

• Utiliser la touche « Tab » pour passer à la mesure suivante 

 

11.2. Paroles 

Les paroles doivent être ancrées sur une note 

• Sélectionner la note où vous souhaitez que les paroles commence 

• Utiliser le raccourcis clavier « Cmd » + « L » 

• Appuyer sur le tiret à la fin de chaque syllable dans un mot 

• Appuyer sur la barre d’espace à la fin de chaque mot  

• Si une syllable dure 2 notes ou plus, appuyer sur la barre espace ou le tiret une fois pour 

chaque note 

• Si un mot est suivi d’une pontuation, saississez-la avant d’appuyer sur la barre espace  

  



11.3. Équivalence rythmique 

Pour insérer une équivalence rythmique : 

• Cliquer sur le point d’ancrage (Une barre de mesure, c’est l’idéal) 

• Utiliser le raccourcis clavier « Alt » + « Cmd » + « T » 

• Un curseur de texte apparait au dessus, faite clic droit pour faire apparaitre les symboles de 

notes et utiliser la touche égal pour une égalité 

Exemple :  

• Clic droit : sélectionner une noire  

• Touche  « = »  

• Clic droit : sélectionner une croche  

  Nous donnes : Noire = Croche 

 

11.4. Texte divers 

Pour insérer un texte de nimporte quels types : 

• Faire un clic droit à l’endroit désiré et selectionner Text  

• Parcourir les types de textes et choisissez celui qui convient le mieux  

 

 

12. | Mise en page avancée : l’inspecteur 

 

L'outil Inspector est un panneau qui permet d'ajuster divers paramètres et propriétés des éléments 

sélectionnés dans votre partition. Il offre un contrôle détaillé sur l'apparence et le comportement de 

ces éléments. 

 C’est un moyen pratique et rapide de personnaliser différents aspects de votre partition. Pour accéder 

à l'Inspector, vous pouvez appuyer sur les touches "Shift + Cmd + I", ou sélectionner "View > Inspector" 

dans le menu. 

 

12.1. Outil General  

 

• Hide / Show (Masquer / Afficher) : Permet de cacher ou d'afficher l'élément sélectionné. 

• Score / Parts (Partition / Parties) : Donne des options spécifiques à la partition principale ou 

aux parties. 

  



12.2. Outil Playback  

 

• Play on Pass (Jouer lors du passage) : Contrôle si l'élément est joué lors de la lecture. 

• Stress (Accent) : Ajuste l'accentuation pendant la lecture. 

• Velocity (Vélocité) : Contrôle la vélocité pendant la lecture. 

 

12.3. Outil Notes 

 

• Voices (Voix) : Permet de basculer entre différentes voix pour l'élément sélectionné. 

• Color (Couleur) : Change la couleur de l'élément. 

• Size (Taille) : Ajuste la taille de l'élément. 

• Staff (Portée) : Définit la portée pour laquelle l'élément est actif. 

 

12.4. Outil Text 

 

• Font (Police) : Choix de la police de caractères. 

• Size (Taille) : Ajuste la taille du texte. 

• Baseline (Ligne de base) : Contrôle la ligne de base du texte. 

• Spacing (Espacement) : Ajuste l'espacement entre les caractères. 

 

  



14. | Récapitulatif des raccourcis  

 

14.1. Raccourcis visualisé sur clavier 

 

 

 

 

 

 

 

14.2. Liste exhaustive des raccourcis 

 

 

Voir ci-dessous 

 

 

 



Keyboard shortcuts
Feature Windows shortcut Mac shortcut

Files tab

New Ctrl+N N

Open Ctrl+O O

Close Ctrl+F4 / Ctrl+W W

Close All Ctrl+Alt+W W

Save Ctrl+S S

Save As Ctrl+Shift+S S

Creating notes

Notes  Input Notes  Input Notes N N

y / x / e / q / h / w 1/2/3/4/5/6 (on keypad) 1/2/3/4/5/6 (on keypad)

§ / # / b (on/off) 7/8/9 (on keypad) 7/8/9 (on keypad)

> . —(on/off) / * - = / *

Rhythm dot . (period) . (period)

Create note A/B/C/D/E/F/G or play note/chord 
on MIDI keyboard

A/B/C/D/E/F/G or play note/chord 
on MIDI keyboard

Create rest 0 (on keypad) 0 (on keypad)

Add interval above 1/2/3/4/5/6/7/8/9
(on main keyboard)

1/2/3/4/5/6/7/8/9
(on main keyboard)

Add interval below Shift+1/2/3/4/5/6/7/8/9
(on main keyboard)

1/2/3/4/5/6/7/8/9
(on main keyboard)

Add pitch above Shift+A-G A-G

Tie (on/off) Enter (on keypad) Enter (on keypad)

Start a new voice N Alt+2/3/4 N 2/3/4

Flexi-time

Flexi-time Ctrl+Shift+F F

Stop Flexi-time Space Space

Flexi-time Options Ctrl+Shift+O O

Editing notes

Edit pitch A/B/C/D/E/F/G or play note/chord 
on MIDI keyboard

A/B/C/D/E/F/G or play note/chord 
on MIDI keyboard

Edit note value: y / x / e / q / h / w; 
start/stop re-inputting pitches

1/2/3/4/5/6 (on keypad) 1/2/3/4/5/6 (on keypad)

Edit accidental: § / # / b (on/off) 7/8/9 (on keypad) 7/8/9 (on keypad)

Edit articulation(s): > . —(on/off) / * - = / *

Turn into rest(s) Delete / Backspace Delete / Backspace

Turn into individual rest(s) 0 on first Keypad layout 0 on first Keypad layout

Notes  Input Notes  Respell Return (on main keyboard) Return (on main keyboard)

Cross note/chord/rest to staff above/below Ctrl+Shift+/ /



Keyboard shortcuts
Standard notehead Shift+Alt+0 (on main keyboard) 0 (on main keyboard)

Change notehead Shift+Alt+0/1/2/3… 
(or two digits)

 0/1/2/3… (or two digits)  

Next notehead type Shift+= =

Previous notehead type Shift+– –

Swap voices 1 and 2 Shift+V V

Note Input  Note Input  Transpose Shift+T T

Note Input  Arrange  Arrange Ctrl+Shift+V V

Keyboard window

Toggle QWERTY input Shift+Alt+Q Q

Up octave (in QWERTY input) X X

Down octave (in QWERTY input) Z Z

C (in QWERTY input) A A

C# (in QWERTY input) W W

D (in QWERTY input) S S

Eb (in QWERTY input) E E

E (in QWERTY input) D D

F (in QWERTY input) F F

F# (in QWERTY input) T T

G (in QWERTY input) G G

Ab (in QWERTY input) Y Y

A (in QWERTY input) H H

Bb (in QWERTY input) U U

B (in QWERTY input) J J

C above (in QWERTY input) K K

Creating objects

Create menu Shift+F10 / right-click 
(with nothing selected)

Control-click 
(with nothing selected)

Home  Bars  Add  Add Bar at end Ctrl+B B

Home  Bars  Add  Add Single Bar Ctrl+Shift+B B

Home  Bars  Add  Add Irregular Bar Alt+B B

Notations  Common  Clef Q Q

Text  Chord Symbols  Chord Symbol Ctrl+K K

Review  Comments  Add Comment Shift+Alt+C C

Home  Instruments  Add or Remove I I

Home  Instruments  Change Ctrl+Shift+Alt+I I

Notations  Common  Key signature K K

Notations  Lines  Line L L

Slur slur S (then space to extend) S (then space to extend)

Crescendo/diminuendo hairpin H/Shift+H 
(then space to extend)

H/H (then space to extend)
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Text  Rehearsal Marks  Rehearsal Mark Ctrl+R R

Notations  Symbols  Symbol Z Z

Notations  Common  Time signature T T

Note Input  Triplet  Triplet Ctrl+3 (on main keyboard) 3 (on main keyboard)

Other tuplet Ctrl+2–9 (on main keyboard) 2–9 (on main keyboard)

Creating text

Expression Ctrl+E E

Lyrics line 1 Ctrl+L L

Lyrics line 2 Ctrl+Alt+L L

Technique Ctrl+T T

Tempo Ctrl+Alt+T T

Editing text

Start editing Return (on main keyboard) / F2 / 
double-click

Return (on main keyboard) / 
double-click

Stop editing Esc Esc 

Move left/right a character / /

Move left/right a word Ctrl+/ /

Move to start/end of line Home/End none

Move to start/end of text Ctrl+Home/End /

Select word double-click double-click

Select next/previous character Shift+/ /

Select to end/beginning of word Ctrl+Shift+/ /

Select to end/beginning of text Ctrl+Shift+Home/End /

Select All text Ctrl+A A

Delete previous/next character Backspace / Delete Backspace

Delete previous/next word Ctrl+Backspace/Delete -Backspace/Delete

Replace selected text type new text type new text

New paragraph Return / Enter Return / Enter

New line Shift-Return Return

Bold/italic/underline on/off Ctrl+B/I/U B/I/U

Default font Ctrl+Alt+Space ^-Space

Advance to next note/beat (lyrics/chord symbols/
figured bass/fingering)

space space

Hyphens to next note (lyrics) – (hyphen) – (hyphen)

Elision (lyrics) _ (underscore) _ (underscore)

Non-breaking space/non-breaking hyphen (lyrics/
chord symbols)

Ctrl+space/hyphen -space/hyphen

Word menu Shift+F10 / right-click Control-click

f / m / n / p / r / s / z (Expression text) Ctrl+F/M/N/P/R/S, Ctrl+Shift+Z F/M/N/P/R/S, Z

cresc. / dim. (Expression text) Ctrl+Shift+C/D C/D
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Keyboard shortcuts
y / x / e / q / h / w / § / # / b Ctrl+1/2/3… (on keypad) 1/2/3… (on keypad)

à / è / ì / ò / ù Ctrl+Shift+Alt+A/E/I/O/U ` followed by letter (e.g. `A)

á / é / í / ó / ú Ctrl+Shift+A/E/I/O/U E followed by letter

ä / ë / ï / ö / ü Alt+number from Character Map U followed by letter

â / ê / î / ô / û Alt+number from Character Map I followed by letter

ç / Ç Alt+number from Character Map C / C

Other special characters Alt+number from Character Map use Keyboard Viewer utility

“ / ” (smart quotes) Alt+2 / Shift+Alt+2 ] / ]

‘ / ’ (smart single quotes) Alt+’ / Shift+Alt+’ [ / [

… (ellipsis) Alt+0133 (on keypad) ;

© Ctrl+Shift+C C

| (Lyricist/Title/Copyright) Ctrl+Shift+P P

$ (Tempo) Ctrl+Shift+4 ($) 4 ($)

Ø (Tempo) Ctrl+0 (zero) 0 (zero)

< / > (in metric modulations) Ctrl+[ / ] [ / ]

Harp pedal diagrams (Technique text) Ctrl+Alt+7/8/9/+ (on keypad) 7/8/9/+ (on keypad)

Guitar tab

Change fret 0/1/2/3… (or two digits, on main 
keyboard)  

0/1/2/3… (or two digits, on main key-
board)  

Move left/right through bar / /

Move up/down a string / /

Move to top/bottom string Ctrl+/ /

Bend J (then space to extend) J (then space to extend)

Pre-bend / slide / notehead in parentheses –  / . (period) / 1
on second Keypad layout

* /. (period) / 1
on second Keypad layout

Quarter-tone sharp (shown as 0.5) = (on main keyboard) = (on main keyboard)

Playback & video

Play  Transport  Play or Stop Space Space

Play  Transport  Play  Replay Ctrl+Space -Space

Play  Transport  Play  Play From Selection P P

Rewind/fast-forward (in 0.2 second steps) [ / ] [ / ]

Move backward/forward by a single frame Shift-[ / ] [ / ]

Stop playback Esc Esc / . 

Play  Transport  Play  All Notes Off Shift+O O

Move Playback Line to Start Ctrl+[ [

Move Playback Line to End Ctrl+] ]

Move Playback Line to Selection Y Y

Go to Playback Line Shift+Y Y

Live Playback Ctrl+Shift+Alt+L L
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Mixer (show/hide) M M

Hit Points Shift+Alt+P P

Editing objects

Undo Ctrl+Z Z

Redo Ctrl+Y Y

Undo History Ctrl+Shift+Z Z

Redo History Ctrl+Shift+Y Y

Cut Ctrl+X X

Copy Ctrl+C C

Copy to where you click Alt+click -click

Copy to where you click, putting copy at default
vertical position

Shift+Alt+click -click

Home  Clipboard  Capture Idea Shift-I I

Home  Clipboard  Paste Ctrl+V V

Home  Clipboard  Paste as Cue Ctrl+Shift+Alt+V V

Repeat (note/chord/passage/text/line/etc.) R R

Delete Backspace / Delete Backspace () / Delete

Home  Bars  Delete Ctrl+Backspace  (Backspace)

Home  Edit  Flip (stem, slur, tuplet, tie, etc.) X X

Voice 1/2/3/4/All Voices Alt+1/2/3/4/5 (on main keyboard) 1/2/3/4/5 (on main keyboard)

Home  Edit  Hide or Show Ctrl+Shift+H H

Color Ctrl+J J

Re-apply Color Ctrl+Shift+J J

Equivalent Chord Text Ctrl+Shift+K K

Revoice Chord Diagram Ctrl+Shift+Alt+K K

Navigation

Select first object on page (if nothing selected) Tab Tab

Select next/previous object Tab/Shift+Tab Tab/-Tab

Select previous/next note/chord/rest / /

Select start of previous/next bar Ctrl+/ /

Select part of note/chord/rest, or end/mid-point/
whole of line

Alt+/ /

Select note/tremolo/stem/articulation above/below
in chord

Alt+/ /

Select nearest note in next voice on same staff Shift+Alt+/ /

Select highest/lowest note on next staff Ctrl+Alt+/ /

Move score drag Navigator/paper drag Navigator/paper

Go up/down a screenful Page Up/Down / or Page Up/Down

Go left/right a screenful or page Home/End / () or Home/End

Go up/down a little Alt+Page Up/Down / or Page Up/Down
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Keyboard shortcuts
Go left/right a little Alt+Home/End / or Home/End

Go to top/bottom of page Ctrl+Page Up/Down / or -Page Up/Down

Go to first/last page Ctrl+Home/End / () or -Home/End

Go to selection start Shift+Home  or Home

Go to selection end Shift+End  or End

Home  Edit  Go To  Bar Ctrl+Alt+G G

Home  Edit  Go To  Page Ctrl+Shift+G G

Zoom in/out Ctrl+=/– or +/– on keypad (or 
click/right-click with zoom tool)

=/– or +/– on keypad (or click/-
click with zoom tool) 

100% zoom Ctrl+1 1

Fit to page zoom Ctrl+0 0

Moving objects

Move object(s) (in larger steps; 1 space by default) /// (Ctrl+///) /// (///)

Move objects, snapping to good positions while
moving

Shift-drag -drag

Move staff/staves up/down 
(in larger steps; 1 space by default)

Alt+/ (Ctrl+Alt+/) 
or drag

/ (/) or drag

Move staff/staves up/down independently
(in larger steps; 1 space by default)

Shift+Alt+/ 

(Ctrl+Shift+Alt+/) 
or Shift+drag

/ (/) 

or -drag

Move note/rest/accidental/rhythm dot/end of tie
(in larger steps; 1 space by default)

Shift+Alt+/ 

(Ctrl+Shift+Alt+/)

/ (/)

Move a note, rest, or range selection to the previous
or next note or rest and swap places.

Control+Alt+/ /

Move line (either end) or lyric to next/previous note space/Shift+space space/-space

Multiple selections & passages

Select bar click staff (avoiding notes etc.) click staff (avoiding notes etc.)

Select bar in all staves Ctrl+click staff -click staff

Select all bars in staff (on one system) double-click staff double-click staff

Select all bars in all staves (on one system) Ctrl+double-click staff -double-click staff

Select all bars in staff throughout score triple-click staff triple-click staff

Home  Bars  Select Bars Ctrl+Alt+A A

Home  Select  System Passage Shift+Alt+A A

Extend passage to object Shift+click -click

Extend passage by a note/rest Shift+/ /

Extend passage by a bar Ctrl+Shift+/ /

Extend passage by a staff Shift+/ /

Home  Select  Select All (of score) Ctrl+A A

Select all noteheads in chord (Select More) Ctrl+Shift+A or double-click A or double-click

Select all text on staff in same style (Select More) Ctrl+Shift+A A

Select objects with marquee Shift+drag on paper -drag on paper
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Add/remove object to/from selection Ctrl+click -click

Home  Clipboard  Select Graphic Alt+G G

Home  Select  None Esc Esc / .

Filters and Find

Home  Select  Advanced Filter Ctrl+Shift+Alt+F F

Filter Dynamics Shift+Alt+D D

Filter Voice 1/2/3/4 Ctrl+Shift+Alt+1/2/3/4 1/2/3/4

Filter Top/2nd/3rd/Bottom Note or Single
Notes 

Ctrl+Alt+1/2/3, 
Ctrl+Shift+Alt+B

1/2/3, B

Find Ctrl+F F

Find Next Ctrl+G G

Layout

Document Setup Ctrl+D D

Hide Empty Staves Ctrl+Shift+Alt+H H

Show Empty Staves Ctrl+Shift+Alt+S S

Focus on Staves Ctrl+Alt+F F

System Break on/off Return (on main keyboard) Return (on main keyboard)

Page Break on/off Ctrl+Return (on main keyboard) -Return (on main keyboard)

Special Page Break Ctrl+Shift+Return (on main 
keyboard)

-Return (on main keyboard)

Lock Format Ctrl+Shift+L L

Unlock Format Ctrl+Shift+U U

Make Into System Shift+Alt+M M

Make Into Page Ctrl+Shift+Alt+M M

Align in a Row/Column Ctrl+Shift+R/C R/C

Reset Note Spacing Ctrl+Shift+N N

Reset Position Ctrl+Shift+P P

Reset Design Ctrl+Shift+D D

Reset to Score Position Ctrl+Shift+Alt+P P

Reset to Score Design Ctrl+Shift+Alt+D D

Condense/expand note spacing
(in larger steps)

Shift+Alt+/ 
(Ctrl+Shift+Alt+/)

/ (/)

Use Multirests (in Auto Breaks) on/off Ctrl+Shift+M M

House Style

Engraving Rules Ctrl+Shift+E E

Edit Text Styles Ctrl+Shift+Alt+T T

View options

Panorama Shift-P P

Hidden Objects (show/hide) Shift+Alt+H H
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Keyboard shortcuts
Object Rulers (show/hide) Shift+Alt+R R

Staff Rulers (show/hide) Ctrl+Shift+Alt+R R

Transposing Score Ctrl+Shift+T T

Navigator (show/hide) Ctrl+Alt+N N

Keypad (show/hide) Ctrl+Alt+K K

Keyboard (show/hide) Ctrl+Alt+B B

Fretboard (show/hide) Ctrl+Alt+E E

Playback (show/hide) Ctrl+Alt+Y Y

Mixer (show/hide) Ctrl+Alt+M M

Ideas (show/hide) Ctrl+Alt+I I

Parts (show/hide) Ctrl+Alt+R R

Compare (show/hide) Ctrl+Alt+C C

Video (show/hide) Ctrl+Alt+V V

Hide/Show Tool Windows Ctrl+Alt+X X

Switch between full score and part W W

Next Part Ctrl+# ~

Previous Part Ctrl+Shift+# ~

Full Screen Ctrl+U U

Windows and dialogs

Inspector Ctrl+Shift+I I

Move to next/previous box in dialog Tab/Shift-Tab Tab/-Tab

Select consecutive items from list Shift+click or drag drag

Select separate items from list Ctrl+click -click

OK (or default button) Return/Enter Return/Enter

Cancel Esc Esc / .

Keypad layouts F7–F12 F7–F12

Next Keypad layout + (on keypad) + (on keypad)

Back to first Keypad layout F7 / Shift-+ – (on keypad) / F7

Contextual edit menu Shift+F10 / right-click on selected 
object(s)

Control-click on selected object(s)

Change window Alt+Tab ~

Hide application none H 

Minimize window none M 

Miscellaneous

Sibelius Reference Guide F1 ?

Print Ctrl+P P

Preferences Ctrl+, ,

Quit/Exit Alt+F4 / Ctrl+Q Q
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